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Only integer versions are authorised for development. 

0 

0.1 03/10/2022 Initial draft versions not released for review N/A 

0.2 06/10/2022 New draft version with amendments following the document N/A 
being used in a training session. 

0.3 07/10/2022 Typo corrections. N/A 

0.4 20/10/2022 Further amendments identified during KT session N/A 

0.5 09/11/2022 New Section 2.8 Creating the POL All Live Defects Report has N/A 
been added that details the instructions for creating the POL 
All Live Defects Report 

No other changes have been made to this document other 
than what has been detailed above. 

0.6 11/11/2022 Added an instruction for new potential or confirmed Defects to N/A 
add the "Date first logged at HDR (dd/mm/yyyy)" as the date of 
the HDR Meeting that this will be presented to POL for the first 
time. 

No other changes have been made to this document other 
than what has been detailed above 

0.7 07/12/2022 Amended section 2.8 Creating the All Live Defects Report to N/A 
include reporting against the new Response Category 
"Accepted Live Defects". 

No other changes have been made to this document other 
than what has been detailed above. 

0.8 09/12/2022 Amended section 2.8 Creating the All Live Defects Report to N/A 
include reporting against the new Response Category 
"Accepted Live Defects". 

No other changes have been made to this document other 
than what has been detailed above. 

0.9 20/01/2023 Amended section 2.8 Creating the All Live Defects Report to N/A 
include column names and removed Paul Smith from the POL 
DL for sending the report to POL. 

0.10 16/0312023 Accepted changes from version 0.9. N/A 

Amended section 2.5 Sending POL the Weekly HDR Report to 
reflect that this report is sent to Michelle Stevens at the Post 
Office and not Lisa Millar. 

Amended section 2.8 Creating the POL All Live Defects Report 
to reflect that this report is sent to Michelle Stevens at the Post 
Office and not Lisa Millar. 

No other changes have been made to this document other 
than what has been detailed above. 

1.0 17/03/2023 Approved version N/A 

1.1 02/08/2023 Amended the Section 2.8 Creating the POL All Live Defects N/A 
Report to include the Microsoft Information Protection steps 
that need to be followed in order to produce the report. 

No other changes have been made to this document other 
than what has been detailed above. 
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• (date by which comments should be returned) 

• (author's email) + POA Document Management 

Role Name 

(* ) = Reviewers that returned comments 

0 

References should normally refer to the latest approved version in Dimensions; only refer to a 
specific version if necessary. 

Ii -

PGM/DCM/TEM/0001 See note See note above POA Generic Document Template Dimensions 
(DO NOT REMOVE) above 

PGM/DCM/ION10001 POA Document Reviewers/Approvers Dimensions 
(DO NOT REMOVE) Role Matrix 

Alphabetical order 
please 

SVM/SDM/PRO/4317 Latest See Dimensions POL Horizon Defects Review Terms Dimensions 
of Reference 

SVM/SDM/PRO10875 Latest See Dimensions Application support Strategy Dimensions 

CS/MAN/011 

O.5 Abbrevatons 
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SPM Sub Post Master 

PBS Payment and Banking Service 

PROD OUT Production Out Date 

SME's System Matter Experts 

HTML Hyper Text Markup Language 

PNG Portable Network Graphics 

JPEG Joint Photographic Experts Group 

CBIF Customer Business Impact Forum 

POL Post Office LTD 

MGT Management 

TfSNow TRIOLE for ServiceNow 

PEAK Peak Incident Management System 

1 . • 

0.7 Changes Expected 

r l 
Fujitsu Services endeavours to ensure that the information contained in this document is correct but, while every 
effort is made to ensure the accuracy of such information, it accepts no liability for any loss (however caused) 
sustained as a result of any error or omission in the same. 

0.9 Information Classification 
The author has assessed the information in this document for risk of disclosure and has assigned an information 
classification of FUJITSU RESTRICTED. 
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10 PRmt 
This document describes the way in which the various internal and external Defect Management reports 
are produced for LIVE Defects including branch impacting. It can be used as a procedural document that 
can be referred to and updated in l ine with changes and/or improvements that are made to the Defect 
Management reports as they evolve and change owing customer or internal requirements. 

Svçi ç rK.)I • Reporting 
'.J •iiYTi . 

1.2 The Goal 
• If the Live Incident or Live Defect affects, or could affect, branch operations, we share it with POL 

in a weekly HDR Report and at the Horizon Defect Review (HDR) weekly meeting 

• The Defect Management reports are produced for internal and external distribution in order to 
demonstrate Fujitsu's management and communication of the LIVE affecting defects including 
those that have a branch impact. 

• The LIVE affecting defects reported to POL will have one or more of the following collections 
added in order to qual ify as a candidate for reporting: 

o ##LiveAffectingDefect 

o HDR-FIN — Horizon Defect Review — Financial Impact 

o HDR-EXP — Horizon Defect Review — SPM Experience 

• These Defects could be in various stages whi lst reporting on them to POL: 

o INVESTIGATING - A Live Defect wi ll start out as a Potential Live Defect unti l sufficient 
investigation has taken place 

■ [Fujitsu internal unless linked to a bonded Incident] 

o SOLUTIONING - If a fault is confirmed then this will progress to be a Confirmed Live 
Defect (if it is not a fault then the Potential Live Defect will be closed) 

• [Fujitsu internal as a solution still needs to be identified and agreed] 

o PROPOSED FOR - Once a solution is identified for a Confirmed Live Defect it wi l l need 
to go through the POA processes before the fix is assigned to a sensible Release 

■ [Fujitsu internal involving developer / feature confl ict check. Counter defects are 
discussed with POL] 

o TARGETED AT - Releases are then managed through to deployment to Live 

■ [Visible to al l parties as the Release work starts] 
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To create the weekly HDR Report, which is shared with POL, follow these steps: 

o The criteria to be used to determine HDR reporting candidates to share with POL wil l be 
determined by creating a list using the following logic. The resulting l ist allows for the HDR 
candidates to be identified. 

o Prepare the report to send to POL 
• A spreadsheet format has been used to date so the previous week's POL "HDR Defects 

update report — dd.mm.ccyy v1.0.xlsx" submission should be used as the basis for the 
new report — removing all previous week highlighting and deleting rows scored out as 
POL have been told these are being removed. 

• Save the file as vO.1 initial ly and use v1.0 for the version that is shared with POL. 
As a visual reminder add WIP into cel l B2 and lastly delete the "HDR Report" 
Tab, which contains last weeks extracted data. 

• It may be easier to create several draft versions i.e. v0.1, v0.2, v0.3 etc during 
the creation of the report, so that it is in a state suitable to create v1.0 to share 
with POL. 

• Amend the date in F3 making sure to leave it as a text field or the title of the 
section below it will not render correctly 

o Create the Peak extract to build the report from 
• Then, open any version of the "Peak Defect Managementextract dd.mm.ccyy 

hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab 
"##LiveAffectingDefect" and click Refresh All. The password to run the embedded 
queries needs entering 3 times and is .€RRELEVAn,r. Save the resulting file with the 
timestamp to match when the extract was created — so it can be referred back to. Turn 
off AutoSave 

o Quick filtering method: 
• Go to the "HDR Report Pivot" tab 

......................................................... ................................................................................................................................................................................................. 
~y y 

• Right mouse click on any part of the filter values at the top and choose "Refresh" 

: PROD OUT Planned Date tM 3i~k A €e 
Respoise Category (NU py 7 

HDR Ciassafica#inn tMt ++ ' " 
(Deferred (All Ltd
PB5 Project , &l. LI E L 

Count of Summary 5ef resh 

~.;...... . .l Moue > 

i..... .......... ......... ......... . ......... ......... ... ... .. ....< 
1K RemQre "RD p Classi?icztion"

Pi "tTab€eQptium_ 
... . _... 

E Hid F ed. Li.,t 

• Check that all the filters are accurate and match the description shown: 
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REFRESH Iear• A ffe:Yi,''r, f' tTAR THFN RFFRF{H TH I SPIVGT ANDCHECY THE FILTERS AS SHOWN 

pRODCUTP3n—el Date iM:rftfpiel:emg3-T CH cc. - . .] r:!T - , .:f n;:3 •; 3, ' E ;F . t :<: i A—dM—it 

: porse Categer 9 (Makip3e 1*crosp; T: h.-r'.- t. . t== Res r: t•.zc r= alE ~t ._; . . . .
.__ _. .. . . ..... 

STat~JS AgUE;fpe l;em<_}:,. -!

HDF. CI~ss f:cai:a- (MuftipTT Items} - ~~- "tt En- .a_:~ ...:  -eEe or -leers ooatc a, ..aci.dedl...

Deferted iA4:I et r, Te.

c: 'cic it:=_li ' erfTt,5fl tc ffpas_±:zi -.ih sct far r_p—':-g ename'tre ahta Deferred`PRS(Other 
• Cnunt Ef Summary ,. . . 

Ensure that you have set Deferred and PBS Project to (All) 
Pay special attention to the `PROD OUT Planned Date" which may have had new future 
dates added that need to be ticked 
Call Type Defect identified; 
PROD OUT Planned Date (M.uItiplettefTs

Status; .F;t9s'o"If~gs21 sn
HDRCi _..~C3/CGf24L' 
Target.: L..; i2g22 

BIF PMa .... iI21C2J2v"Z2' 

PT' Ply `-.23/CZf2522 

B3f_Tie .- ~1 I6/C3/20ZZ 

ActiEsru ' i^ t"lfl2fZ#122 
..........._.,, ...713'JC312C2 

~1~31/0s2dr22 D 
'.CauTe~G~j M . . 

_.. ... .~ Select Multiple lter:~,s 

4K Came 

List — Deferred, Project and HDR Live Defect Peaks 

PROD OUT Planned Date 

Response Category 

Status 

HDR Classification 

Deferred 

PBS Project 

(Multiple Items) J .

(Multiple Items) T 

(Multiple Items)

(Multiple items) iT 

(All) 

(All) ' 

• If there are any Deferred, Project and HDR Peaks to consider, a number will appear 
under the Count of Summary 
Count of Summary 

30 

Double cl ick on the number to open a new sheet with the relevant Peak(s) listed 
and rename it "HDR Report". 
It is more likely that the result set largely matches the previous results showing in 
the HDR Report. 
Compare the previous HDR report to the new list and amend accordingly so the 
new HDR report list matches what the system now shows 

o To do this it is worth hiding the following columns as it makes to easier to 
compare the data against the previous HDR Report: 
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® N - TfSNow Reference 
® 0 - POL SNOW Reference 
■ P - Contact Name 
® R - Business Impact 

• It is good idea to mark for each Defect PEAK the "Call Reference", "Description", "Target 
Release Type" and "Target Release" red on the HDR Report tab of the 
"Peak- Defect- Management extract dd.mm.ccyy hh.mm.xlsx" once checked against the 
previous HDR Defects Update Report dd.mm.ccyy.xlsx. 

• Also check column AH "Planned Out Date" to ensure that any dates previously reported 
against in the HDR Defects Update Report under "Current Target Release Date" have 
not been amended or if any new dates have been added for Defects that had previously 
been blank. 

• If any dates have been amended or added, then please add to the Current Target 
Release Date of the HRD Defects Update report and add a new HDR extract. 

• Also check column AG Date Time Last Updated to see if any Defects have been updated 
in the last week. If so, check the Defects to identify the changes and if the Impact Tab 
has been updated then please add to the HDR Report. Other updates such as comments 
added to the Detail Tab may not require to be communicated to the customer as this 
could a JIRA reference or log needed to further investigations. 

wad. "••zm.}::x»...„ .aY,'IDk¢:~,a ~>....,,a` t .dc'.ai.. - -~ .....~,se➢mkxf 
-h... 

.., x>:, ~ - ;s.a~a._.,~,~tt°a" . '~+Atia^z#..,.: 
P10302913 -' Eti - PIN Pa Defect idea' %tveAffectir: No The PIN Pad status r c.sed ror HN0-:x 73.10 
.( 99$9 SL ¢kE,te s ):E Defect lden- FlDtt-Fr:n, tr#€rv'res Durng Exasnngg Rev Repored in HNG-X 9F.I, MO. .............................................................................................................................:........................................................................................................................................................................... 
0/0302437 Trar>sac-Eton;Defeetlden'HDR-Fin,?#?€tvYes It a counterperforrTar etedA. H Ir3:X7 .30 
PC039135r. 075 reoorts ! Defect lden, H DR-Fin, ##€ivYes .11....1 1 .. After a failed stock Targeted A, HrfG-;2 72.30 

03:.32293 
. .. ... ...... ........ 

EAL Ox -NO. Defect lden?.SS£3rd; ##UveYes .... ........1 ..1 11 
. 

.:... If a clerk uses the T T 1 -gete d At HNC -X 38.04 

Customerr Defect en:HDR-fi!, ??tFFt'Yf."5 Dorir1gt9 S;7 a=.Keti0rorjeie'.i For HNG-x73.:1.0 ___.. . ........... 1111 .... . ..... . ..... 1111.. . 111 1 ...... .... . . ...... 1111. 1111. . ..... 
DIEM - Trans: Defect ldenl##YtveAffectirNo 

.. .. _...__....... ... __....._.:. .....__... . ..... ...... _..-. 
If Transaction logs Targeted A* 

1111 1111. 1 111 .. . ..... 1111.. 
HNG-X 72,30 

37 3 cu >e : F:x Defect Iden'.SSC3rd, ee tvEYes If a cleric uses39e T Pt ooe ed For HNC-X 73.90 
00F N1102.' Defect Iden! HDR Fin, ##LIvYes Declinedtransactio9cportedIn 1402l<Rd. ,rid. 

?FSNe~.: gDefecttderi DR-fin>?+#CrvYes .. ..... 1111 1111 1111 . .- _..- Ttts Issue Eethereltaeefd.A H`3L 2.3rt 

iE'3f973 ;14F-96.2'0'Defectlden:HDR-Firr,##UvYes AP Transaction(AutTxgetedAi 14 009-N 37,09 
r 3 9'3 

.... . ... . ..... . .... . .. . . . ..... 1111.. .... ......_ 
of c„ (< ,: Defect Idenr# _veAf#ectf^No 

1111. ....__....._ ... _....._. .. 
I# a PBS Salarsee Ent rr , c e l F_,r 

. ...1 . 111 . ... .. .... 
HNG-X 73.90 

00292023 PES. Fegress Defect td@n? HDR-Fl 3, #H€IVY s In rare cases, ;r•reve Ta gated At H IG•X 72.220 
010293399 .... ....... . . ... ...... . . .. .. €105 trar:sact Defect lden-HDR-Fin,,SSCFYes .. .. . .... . .... .... . ..... ..... . ... ...... . . . ...... .. .. .... If the user presses Targ;et_I Al ..... .. ._ _1111 _1111.. . .._ _....._.,... _ _... _..... .. ... _.... 14000 72.20 

?t'.02333:2- 005 Counter Detect den'.5SCRar,dR,4f No On PBS co ters wi Targct. 'i t. 1400-072.20 ................................................................................................................................................................................................................................................................................................. 
P10232037 .9T:97';.90- Defect lden't?#l1iveA`fectt^:No Businessin-ipact:IN?ropwsedFor 

_1111.. 
1400-:073.90 

PCO297995 €ST:R71.10- Defect Iden'#r''siveAffectir No Business Impact; If Proposed ,Foc 1400-073.10 

- Ct;2372w €..T. . -.10 - Defect lden O#aiveA`tecmlr No DuringExistlng Rev Propceed For 1400-073 _ 10 

05097949 LS1 ZR71.10-1 Defect Iden'## IveAf#ecttrYe.s There have been r:< ro>>osed For • H V;:-:•t 73.10 

C0797962. 
... . . . .. ..... 1 111. 1 111 1111 1 111. . . . . ....._ . .. . ..... 

LST:R71.'10- Detect iderr#k veAffec#irNe 
.... .. ... _..- 1111. 1 111. 1111. 1111. ..... .... .. ... _.... 

xistingReversalssPrnpcsed:For ; 

.... . . .... ..... ... .. .... 
1400-07.3.10.... 

P102'37676 
.. ... ... .- ._ .. .. ...... . .... . .. ... 

PE':LT:R?1, Defect tden'91FAoproved, No 
........ . ... .. 1111. 11 1 .....1 .. ... . ..... . .... 

When aP95benktnT'arget-ed..At 
1 ..1 1 1 ... . ... . .. ...... 

H00-X72.20 

. Ct:295 _ T 970.401 Defect Idea BI Ap roved. Ne 
1111.+:f:lS~,f 

PBSI€does not tr5ap Prrcse. ,=..,r 1400-073.10 
010294925 i5. . ..n Defect lden`Sattars, .sscctNta ..... When help pages h Tyr $ed.A' 1400-072.30 1 111.. 1111- _..- . 
P0(2335,35 

..... ...... . ...... ..... .... . ..... ..... _..- . ...... ...... ..... 
CS.0-5r50c5 - 1. Defect lden :_EveA`fecftr 

.... ..... . ..... ..... ...... ...... ...... ..... .... ..... ..... 
Iri particularly rare i ro;,r,=.e i'or 

..... 1111.. 1111.. .... . ..... 
1403-0 73.3.0 

-193;3: 970.10' J Defect lden'BlFAAppravec, Nc For4P-ADCtransacrargetedA* 1400-0 7220 

029252 :007979929 -Defectidcn SEC 4th Lois.No See Title, this is be Provc--.l -, jr HN£ X7510 

P00292275. CDD 5259 - H Defect Idenr BtFApproved, The history text ge?''r :nosed r r 
_ 1111 

1400-073.10 

00230315 ''ST:fir_€ iND Defect lden'B1FAaproved, No .. ..... .. .. .... .... .. -....< .. . : 1111. . . .. When the Clerk att Proac-seJ For H0(9-073. 0 ...... ... .. 1111 1111. 
0026997 

_.- ...... . ..... . 
€ST975320f Defect lden'BWFApprnved,Yes 

. ....._..... .. ...... . ....:. .... : ..... .. .. . ...... . .... 
During a RemInfoPromce.9For 

1111. 
H00-073.30 ................. ........................... .........:...................................................... ............................................................................ ...... ...-......................................................... .................................. . . . . 

00299227 970 30-510 Defect Iden' BtFApproved, : For some bats of`itTa-geted At HNG-X 72.20 

Any that have been closed should be moved to the HDR Closed Defects section of the 
HDR Report and highl ght in yellow: 
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• Any that are new should be added to the list and highlighted in red on the HDR Report 
tab whilst they are checked and completed 

o These then need scrutiny to ensure they look correctly tagged as HDR. 
This will require the Peak to be read and checked 

o If they are HDR, then the Impact tab needs checking to ensure it is 
complete and reads well. Any amendments should be referred to the 
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o Ensure that the Date first logged at HDR (dd/mm/yyyy) is completed with 
the date of the next meeting (normally a Monday) for which this potential 
or confirmed new Defect will be presented to POL in the HDR meeting. 
Field from the Impact Tab illustrated below: 

Datt first 1oggtd at HDR (Jc "mar yy v) 24/10[2022 

o When the report is ready to submit, the highl ighting on the new rows 
should be changed to yellow 

o Extract the list showing: 
HR f~<- 

o POL Reference (from column BI) 
o POL Title (from column BN or set to N/A for a new entry) 
o Category (from column BF) 
o Fujitsu Reference (the Peak Call Reference from column A) 
o Summary (the Peak Summary field from column B) 
o Confirmed Defect (set to "Yes" if Call Type in column F is "Defect 

Identified" or "No" otherwise) 
o Workaround (from column Q) 
o Update (manually updated to pick out any changes made week to week 

on the Peak in question — if nothing has changed (as is typical once a 
Peak is Targeted At) then the "No change since dd/mm/ccyy" wil l 
probably be ok to leave as is. If any updates are identified, set this cel l to 
YELLOW FILL 

o Target Release Type (from column S) 
o Target Release (from column T) 
o HDR Extract 

■ Create the file to embed: 
• This is created within Peak from the Impact tab 
• Open the Peak and go to the Impact tab 

■ Click on the Export icon on the top right 

r11 
L: 

■ A view of the Impact screen is presented in a new window 
■ Right mouse click and choose "Save as" 
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■ Save the file 
o Embed the fi le 

• Click on the cel l into which the saved HTML file is to be 
added 

• Click on the Insert menu option at the top 

orno nsert. Page Lay€ 

• Click on Object in the Text section 
' W*rct t. W

J
:s"f Slgrsats~ee '~Frfe -~ 

lect {' idc r 

to &. Footer —'I Cbj :

-gat 

• Click on the "Create from File" option on the screen that 
appears 
Object ? X 

...................................... 
Create He reate from File 

Fite name:! 

El Lirfk to file 

❑ Disily as iron 

Enzeftz the carte nts ci the f tc hits yaur 
d n cum ent s e tha9. ye u can a tit it !later 

-''- using the pragram c.thFch crated the 
source file. 

• Click on Browse and then navigate to and click on the 
relevant file and select "Insert" 

• Then click OK 
• The file will be inserted into the cell in the HDR report 
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o Screenshots 

■ If any screenshots have been requested or are needed, first 
save the screenshot to a file (PNG or JPEG) 

o Embed the fi le 
• Click on the cel l into which the saved HTML file is to be 

added 
• Click on the Insert menu option at the top 

ome- Insert. Page I.ay< 

• Click on Object in the Text section 

- L -
ao y & i'Fiut€r {-S(.'i:1: 

• Click on the "Create from Fi le" option on the screen that 
appears 
ct 

 
7 

.-- X

........ .............. ........ 
Create Bfew Create from File ..... ......... . .... . ....... .. .......... .. . ............. .. . ............... ...... ................... .... 
File game: 

i . .. . .. .... .. .... . . . .... ... . . .... .... . .... .... . ;, .31 

Link to file 

Display as icon 

.BCs,:'ikE .... . ................. .......... .......................... ........ ......... . ................. . 
Inserts the cantent= of the Lila into yauu 

• d e cum:ent s e that you cane eIt t Pater 
using t  RrQ(Iram which crated the 

. . source file. 

CsK .... ..Cancel.......

■ Click on Browse and then navigate to and click on the 
relevant file and select "Insert" 

• Then click OK 
• The fi le will be inserted into the cel in the HDR report 
■ If it is a PDF document, you will need to click on Display as 

icon checkbox 
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Object ? X 

C4" r_.>:saY~ frotss tEe 

fife dame 
............................................................................................................................. ......:.........:::::::::::::..,.. 

i.'eEhars'sH3eTGl.ER, q..<.keeEySve. Ft... f6;AAss6So5st} epr.7t....iie0.a.. .... 

0 * i t 

3.Y.s?3~IA.~ as ieos 

h`gAu At iet~selw,epxf oral rim<rsp «i 
khe Ne Ec"wa"kamemt. 

FS~~3AA32Y3.~ds.

... ...... ...... ...... .. 
aNtenQa ........,. 

o Click OK and then resize the PDF document in the cell 
o Once all details are added please ensure that all the row illustrating the 

new Defect is highlighted in yellow. 

FYI ONLY — MANUAL FILTERING 
o If the HDR Report Pivot is absent or corrupted, then the manual filtering is as follows 
o Go to the ##LiveAffectingDefect tab and filter as follows: 

• Set the filter on Response Category [column J] to exclude the No Fault Found values 
(see Appendix A) 

• Set a filter on HDR Classification [column BF] to exclude blanks 
• Set a filter on Planned Out Live [column AH] so the dates are in the future or blank (it has 

not been deployed) 
• Exclude closed Peaks where Status [column I] is "C" — as these may have been fixed 

outside of a release by Ingenico themselves 
o Then the 1 List needs to be created that can be used to compare against the previous week's 

report: 
o Deferred Live Defect Peaks 

• Set the filter on Deferred [column BH] to "Yes" 
• These are unlikely to be discussed at HDR as they are previously approved and 

understood but are provided to show the level of Fujitsu control 
o Project Live Defects 

• Set the filter on PBS Project [column BG] to "Yes" 
• These are unlikely to be discussed at HDR as they are part of the ongoing Project 

Manager regular review calls 
o Non-Project Live Defects (l ikely originating from an Incident during normal service delivery) 

• Change the fi lter on PBS Project [column BG] to exclude "Yes" 
• These require more comprehensive information as these will be discussed at the 

HDR meeting 
• Extract the list as described above 

These previously were listed as individual ly in their own sections but is now reported all together. 
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A.1 2.2 Weekly CBIF Submission Extract Work Instructions 
To identify if there are any CBIF submissions necessary to POL, fol low these steps: 

o Create the Peak extract to build the report from 
Open any recent version of the "Peak_ Defect_ Management extract dd.mm.ccyy 
hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab and click Refresh 
All on each tab. The password to run the embedded queries needs entering 3 times and 
Isl IRRELEVANT: Save the resulting fi le with the timestamp to match when the extract was 
created — so it can be referred back to. Turn off AutoSave 

o Quick way 
• Go to the "CBIF Peaks Pivot" tab 

.. 

Right mouse click on any part of the filter values at the top and choose "Refresh" 
CR€I Type Defect ICentified !-T Set to D 

PROD OUT Plainsed Dale 'Mo€tirileite'ns; i,:g`:Settat ....... ... 
Response Categor r l,n  n A A
Sates .. . .... . ......z. 

HOC Classification x°100

Target Rete se...... 

=a€F €'landed Date < Ly copy 
PTF Planned Date. 

`%] Fcrmak Cllr;„
F T€eed Gueet ...... ..... .. .... .... . . ...... .... .. .. .... .e ..h 

Rs?resh :Aetlored Team - 

Lount of Summar 
;xs, f e mn;' e "Tr rget Re€e:,.ee Type" 

F:•res L ,.Ptsns.,. 

3 I-tide Fed List 

Check that all the fi lters are accurate and match the description shown: 
REFPESH eRliveAftectingDefeet TAB THEN REFRESH THIS PIVOT AND CHECKIHE FILTERSASSHOWN 

Cal€ Type Cie€et2.F3enf:fied-s :e.

:PROD OT Planned Date (Mult€pleltemsi :•.f Set to ̀ uture r_!stc_r the *.s. 

Response Cate€oe {Mslt€ple Items; 
i•I... 

Ustickthe he ,:1't >au: ~- •cr:e=_. 

Plaf~s (Mult€ple hens} '-r. ExdudeC _.... . .. .. .__.. __.. .... ... .. . . . ....... .... ..., , ,...... ..,., , , , ......, , ,. ...,.., , , ..... ..,., ,......., , , 
HDRCIass€ficatIoe (blane.} : H"SetEDblartts 

Tenet R@IEa5e Type (Nultlple Sterns} _ V' Exclude Targeted At '.

alt Panned Date (Ib`ultlple lte'is} I. Excludebianks 

PTT Plue'red Date (blan i '.Y:Set tob€a^ks 

SEF Ticked Qtiautions (PFettiple lte'as) :-g'. Exclude bOancs _. . . .. . 

.A~:er:ed Team (bank; X. ett'a b:a'ks 

Do.: E circ tee numberrrxwn toe:eaose the result set (usuail nothing: 

Cmmt of roe nary 
_. . _. . 

Pay special attention to the "PROD OUT Planned Date" which may have had new future 
dates added that need to be ticked 
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Gall Type Deer; sdenbE ied :T S 

PROD OUTPIasnedDate tPluI lialeltem,} iS 

Respor

Status •Li 1sfoi 2 21
HDRCl; ;, ~Je3/O8 202.2
Target L 3/O~ 2= i'.E 

BIF Pla 1'2/cO2>'2O22 `E 

PTF P a i• : 23/(32:2e2? €S 

B1E Tie . i6/53(O22

Acton 4 
; 2/2 2? is ................:. j: s.

hCount 

select Muftipi s 

CK ...,Cancel 

• If there are any CBIF Peaks to consider, a number wi ll appear under the Count of 
Summary 

Count of Summary 

Double cl ick on the number to open a new sheet with the relevant Peak(s) listed 
Go to "Collating the results" below 

Manually filtering way 
• Go to the ##LiveAffectingDefect tab 

..... ... .......... . .... . ... .... . . ..... .... 

• Call Type [column F] is "# - Defect Identified" (a fix is needed) 
• Set the filter on Response Category [column J] to exclude the No Fault Found values 

(see Appendix A) 
• Set a filter on HDR Classification [column BF] to blanks 
• BIF Planned Date [column U] must not be blank (it has to have been to a BIF meeting) 
• Target Release Type [column S] is not Targeted At (as this means it has gone through 

PTF already) 
• PTF Planed Date [column AA] must be blank (it has not been to PTF) 
• Planned Out Live [column AH] date is in the future or blank (it has not been deployed) 
• The Actioned Team [column AJ] must be blank (i.e. not BIF (not ready for CBIF) or PTF 

(gone past the CBIF step)) 
• BIF_Ticked_Questions [column AM] is not blank (BIF selected it for CBIF) 
• Go to "Collating the results" below 

Collating the results: 

• Check that each Peak(s) in the result set is/are correctly marked by reviewing the Peak 
Details and looking at the Release Management (Release MGT) tab for notes that clarify. 
Any Peaks that are confirmed as CBIF candidates then need a CBIF Proposal creating 
as this is what will be submitted to POL. 

• CBIF is part of the HDR meeting and any proposals should be submitted along with the 
weekly HDR report for discussion at the weekly HDR meeting with POL. 
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A.2 Appendix A — No Fault Found Response Category values 
Peaks with the following Response Categories are deemed to be No Fault Found as no action was 
required to remedy the issue raised. In some cases this is because the fault is within an area of the 
system that is managed using TfSNow and hence Peak is not the source of the Live Defect information. 

Response Category — 68 -- Final -- Administrative Response 

Response Category— 95 -- Final -- Advice after Investigation 

Response Category— 94 -- Final -- Advice and guidance given 

Response Category— 70-- Final-- Avoidance Action Supplied 

Response Category — 200 -- Final -- Call withdrawn by user 

Response Category — 120-- Final --Cloned to create Defect Peak 

Response Category— 72 -- Final -- Duplicate Call 

Response Category — 58 -- Final -- Documentation Fix Available to Call Logger 

Response Category — 66 -- Final -- Enhancement Request 

Response Category — 96 -- Final -- Insufficient evidence 

Response Category — 62 -- Final — No fault in product 

Response Category — 63 -- Final -- Programme Approved — No Fix Required 

Response Category— 64 -- Final — Published Known Error 

Response Category — 100-- Final-- Route call to TfS 

Response Category — 97 -- Final -- Unspecified insufficient evidence 

Response Category — 98 -- Final -- User error 

2.3 Updating Updaling the PIVOT Tab of the Weekly Defect Update 
Report 
The Pivot tab of the Weekly Defect Update report provides a table and graph that illustrates 1) 
The Proposed For 2) Targeted At 3) TBC for the Defects displayed in the HDR Report — Open 
Defects by Target Release and HDR collection i.e. Impact and Experience. 

If no new defects are added to the report, then the table and graph can be refreshed to pick up 
any changes by following the below steps: 

• On the Pivot tab, select a cell within the table and then right click, to bring up the menu 
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• On the menu click on refresh to update the table and graph 

ma Ma 
K Y .• ax -az : # & s g>a+ax ,.~ . 5~,  .y ::. R °. vrsw  
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• If new defects have been added to the HDR Report — Open Defects, then select the 
PivotTable Analysis menu bar 
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The Change PivotTable Data Source menu will be displayed 
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• Change the Table/Range to cover all the active rows and then click ok 

• This will then return you to the Pivot Tab 

K:•... SHf{ Ph:~: : f":.+: "16 Vlr ~So- '~/n~ ?t;v '-...$. MI33iS. ;..+il. .::Nti:.. ,5 . D.Y. 
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•• • • ••. • '• Questions in the meetin•;t1iD 

As a result of the weekly HDR meeting there maybe questions raised by POL that you wi ll need 
to read the Defect PEAK or engage the required technical resource to gain the required updates 
to add to the Impact Tab so a revised HDR Extract can be provided in the next HDR Report. 

Additionally, POL may send questions on HDR Defect PEAKS in order to gain clarification, that 
will again need to be added to the Impact Tab so a revised HDR Extract can be added to the 
HDR Report. 

These actions can be performed outside of the producing of the weekly HDR Update Report in 
order to be ready to add the report against the appropriate HDR Defect PEAK in the report. 

• Once all the required changes have been added to the HDR Report, you are now in a position to 
create v1.0 to send to POL by approximately 10:00 on a Friday morning, in preparation for the 
HDR meeting with POL on a Monday morning (Usual ly 11:45). If you send it a l ittle late owing to 
awaiting an update from a technical resource, that is not a big issue as long as it is sent to POL 
by close of play on the Friday. 

o Open the latest draft version of the report i.e. HDR Defects Update Report v0.2 

o Ensure that all the required updates, HDR Extracts and Screenshots have been added to 
the report. This includes checking against the actions from the minutes of the previous 
meeting sent by POL in order to ensure that the required information to answer POL 
questions is included in the HDR Extracts for the appropriate HDR Defect PEAKS. This 
will assist in confirming the status of the Fujitsu actions from the previous meeting. 

o If so, remove the word "WIP" into cel l B2 and save the report as "HDR Defects update 
report — dd.mm.ccyy v1.0.xlsx" 

o Next prepare the email to be sent to POL that the report needs to be attached to. Please 
see example of the weekly email for the HDR Update Report below: 

From: Hatch, Matthew 
Sent: Friday, March 17, 2023 9:53 AM 
To: Michel le Stevens GRG ;, k GRD 
Cc: POA DutMana er _ Y g _.GRO 

. . . . . . . . Lisa.mi
llar-; Bansal, Steve 

(BRA01) GRO Bothick, Sandie 
GRO.--------- --

Browell, Steven
Subject: HDR Defecfs lrpi3afe Repcir£- 17:0 : 02 - v1.0 

Good Morning Michelle, 

There are NO CBIF candidates to put forward this week and NO NEW DEFECTS to 
raise. 

There is also NINE updates to the existing entries, that have been highlighted in yellow in 
the update column. 

Changes to report and updates: 

• The pivot has been updated 
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The NINE updates are: 

1 has had the Target Release Type on the report updated to reflect the 
Defect. (Cosmetic change) 
6 are awaiting an update from POL following a review being performed 
and a decision being made. 
2 awaiting an update on POL Reference Data from Ian Humphries. 

There are NO OPEN ACTIONS for Fujitsu from the previous HDR meeting (13.03), 

Owing to the above, I am happy to approve the minutes from a Fujitsu perspective for the 
HDR meeting held on the 13.03.2023. 

Thanks for your support. 

o Then add the report version 1.0 "HDR Defects update report — dd.mm.ccyy v1.0.xlsx" to the 
emai l and send to 

2.6 Saving the reports, minutes and emails to SharePoint 
In order to have an audit record of the HDR Defect Update reports, emails sent to POL and emails and 
minutes of the meetings sent by POL to Fujitsu, there is a SharePoint location whereby al l of these 
emai ls and documents are held. Following the sending of the weekly report to POL, or responding to POL 
emai ls with questions or the receiving of meeting minutes from POL please save them to the below 
SharePoint location: 

Service Management - Horizon Defects Review (HDR) - started June 2021 - All Documents 
(share point, corn) 

2.7 LIVE Defect Management Monthly Report Creation 
To create the monthly Live Defect Management for POA stack owners and leadership, fol low these steps: 

o Create the Peak extract to build the report from 
• Then, open any version of the "Peak_Defect_Management extract dd.mm.ccyy 

hh.mm.xlsx" spreadsheet and Enable Content and go to the Data tab and click Refresh 
All on each tab. The password to run the embedded queries needs entering 3 times and 
is`IRRELEVANT' Save the resulting fi le with the timestamp to match when the extract was 
created so it can be referred back to. Turn off AutoSave 

Prepare the report 
• A spreadsheet format has been used to date so the previous month's 

"POA _Live —Defect _Management Monthly Report dd.mm.ccyy hh.mm.xlsx" should be 
used as the basis for the new report. To show history, copy the white box on the top left 
of the Summary tab and paste it to the right as an Image (you may need to delete a 
previous image) 

• Save the fi le with the same date and time values as the Peak extract created earlier so 
you know which extract the report relates to 

Go to the ##LiveAffectingDefect tab and filter as follows 

Then the 5 tabs are derived as follows: 

Check the range of values in the Call Type column. If there are any that are neither "Live Incident" 
nor "Defect Identified" then these need to be looked at to decide whether to treat them as one of 
these 2 categories. There shouldn't be any, but if there are, it is most likely to be Vulnerability which 
can be treated as Defect Identified. If so, amend the filtering below where ** is shown. 
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o Still Investigating 

• Clear all filters 
• Filter the Planned Out Live date so it is in the future or blank (it has not been deployed) 
• Filter out the No Fault Found Response Category values (see Appendix F) 
• Filter Call Type to "Live Incident" ONLY ** 

■ Consider filter on Status to exclude "Closed — but beware the closures may be 
wrong 

• Extract the columns shown on the tab from the filtered list and paste the values into the 
report 

• Expand/contract the Stack owner column by copying/pasting the formula so all rows are 
attributed to a name 

o DI — Solutioning 
• Clear all filters 
• Filter the Planned Out Live date so it is in the future or blank (it has not been deployed) 
• Filter out the No Fault Found Response Category values (see Appendix F) 
• Filter Call Type to "Defect Identified" ONLY ** 
• Filter "Target Release Type" to exclude "Targeted At" and "Proposed For" 

• Consider filter on Status to exclude "C"losed — but beware the closures may be 
wrong 

• Manually add back in any that are "Targeted At" or "Proposed For" and Target 
Release is `Re-target" if there are any 

• Extract the columns shown on the tab from the filtered l ist and paste the values into the 
report. 

L'ZI • 1 

Fujitsu have agreed to create a report called "POL Al l Live Defects Report" on a fortnightly basis and 
send to POL. 

In order to create the report please following the below instructions: 

1. Run the "Peak_Defect_Management extract dd.mm.ccyy hh.mm.xlsx" update and rename the fi le 
accordingly 

a. Update the filters on all tabs and Refresh the content 
b. Save the fi le 
c. Turn off autosave 

2. In order to ensure that the new Response Category "Accepted Live Defect" is picked up and 
reported against please follow the below instructions. 

i. In any Pivot tables you should now tick the Response Category "Accepted Live Defect" 
so the entries are included. E.g. 
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Response Category (Multiple lte s1 !I 

Status earn h 

HDR C L.4J Product Error Fixed

•c: Prcgramrne.approved - Nc fix re+ a.... 
Row U  ..[ Published Knoe,n Error 

1-!p Reconciliation- resolved' 

r3-p Route call to TfS 

HI F►ISTW Fi AvailabI:etc Call' Logger 
:,..p Ref Data Fix Availableto Call Lo 

?i Accepted Live Defect 
HI 

sf i/. ri £ Ir i yr y

HI ® Select Multiple Items 

f:5 -AI 
t~K Cancel 

ii. When you update the Pivot tables you will see a "5 — Accepted Defect" entry. I 

recommend you collapse section 5 as follows: 

HNG-:h 73.10 1 

4 5 - Accepted Defect 4 ....... .. 
Grand Total 215 

3. Create the "HNG-X - All Live Defects Report for POL - dd.mm.ccyy.xlsx" file by copying the 

previous version (the POL report) 

i. Update the Front Page to put the correct dates at the top 
4. Go back to "Peak_Defect_Management extract dd.mm.ccyy hh.mm.xlsx" 

a. Go to the Defect Stage Pivot tab and click on the number to the right of Grand Total 
b. This will create a new sheet with all the Peaks on that you need 
c. The columns then need reordering ready for placing into the POL report 
d. In order... 

i. Cut column BI (Defect Status) and paste it prior to column A 
1. Wrap Text wi ll probably switch on so select all content and put Wrap 

Text back off 
ii. Cut column BF (HDR Classification) and paste it prior to column E 

i i i. Cut column BH (Deferred) and paste it prior to column F 
iv. Cut column T (Workaround) and paste it prior to column G 
v. Cut column S (POL SNOW Reference) and paste it prior to column H 

vi. Cut column BI (POL Problem Reference) and paste it prior to column I 
vii. Cut column X (Target Release) and paste it prior to column J 
viii. Cut column BJ (Release Title) and paste it prior to column K 

ix. Cut column BF (PROD OUT Planned Date) and paste it prior to column L 
x. Cut column BN (Impact: Description) and paste it prior to column M 
xi. Cut column BU (Impact: Root Cause) and paste it prior to column N 
xii. Cut column BX (Impact: Fix Required) ( and paste it prior to column 0 

e. Sort column A A-Z (1 - Investigating will be at the top) 

f. For all top rows where Defect Status is 1- or 2- blank out columns J, K, and L 

1. For any rows at the bottom where Defect Status is 5- For any rows at the 
bottom where Defect Status is 5- blank out columns J, K, and L 
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g. Filter column BN (Impact:Date of Issue) to dates AFTER the last report AND including 

Blanks - to show only those that have changed since the last report was run 
i. Filter column E (HDR Classification) to blanks only - the HDR ones will have 

been scrutinised already 
ii. Check columns M, N and 0 read well and request amendments if not - apply 

manual edits to this extract to save repeating above steps 
h. Remove filter column E (HDR Classification) and filter column AW (HDR_Date) to show 

those declared HDR since the last report 
i. Check columns M, N and 0 read well and request amendments if not - apply 

manual edits to this extract to save repeating above steps 
i. Clear the fi lter to show all rows (Menu - Data - Clear for speed) 
j. Select from row 2 until the end and take columns A-O 
k. Copy the text 

Go back to "HNG-X - All Live Defects Report for POL - dd.mm.ccyy.xlsx" 
a. Place cursor on cell A2 and Paste values 
b. Check that there are no extra rows from the previous report - delete if there are 
c. Unhide the tab "By Release" and Refresh it 
d. Select all contents except the header row and then paste alongside as an image 
e. Crop the image to remove the Pivot table "-" symbols 
f. Cut the image and paste it on the Front Page - resize and position correctly 
g. Hide the "By Release" tab 
h. Save the spreadsheet 
i. Select the entire "Al l Live Defects" sheet (top left corner left of A and above 1 
j. Double click a row marker to cause resizing to fit contents 
k. Amend the screen so you can see columns M, N and 0 
I. Slowly scroll down the file adjusting any cell heights where content looks to end oddly to 

ensure all content is visible 
m. File Print and select "Print Entire Workbook" 
n. Set printer to "Microsoft Print to PDF" 
o. Check Preview of all pages 
p. Press Print 
q. Then the below pop up "Microsoft Information Protection" will be displayed 

X: 

Microsoft nfo m tiol rot ction 

Fifes you create from the Print command may lose their 
se.ncitivity labels and other content r ietadeta, such as 
ac:c.ess biltby tag{. 

I ;ontinue to File E p ort to create files that preserve 
,our organizations pxolioiess (reccfmmended .

Print without senItivity label's and other ne#aclata. 

Learn more 

...... =r arrce. .... .... 
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Next you will be required to select "Print without sensitivity labels and other metadata 

x 

Micros oft 

Information Protection 

Files you create from the Print command may lore their 
s;cn itivi labels and other content r setad.ata such as 
ac€esri b: iky tacg s. 

Continueto File> Export to createfiles that p€eser?.e 
your organization's poiicies (recommended). 

Print without sensitivity labels and: other rrretedata:, 

L. earn m of e 

......................................................................................................................................................................... 
:You must Provide ei j tifkatioin for removing protectian. Do 
not indu:.ie s€nsd.:-e it formation in the justdifatton:, 

Cancel I. 

s. Please add a comment that provides justification i.e., All Data is required to be provided 
to the report to customer and the internal DL 

Microsoft info irmatiOlrn Protection 

Files you create from the Print com m and may lore: their 
ren itimit Q labeis and other content.3atadeta audi as 
acre sihilty t- g:s. 

,,' Continue to File Expert to create files that preserve 
your organizations policies iec4anirnended),. 

Print without sensitivity labell, and other metadata.. 

Learn more 

'AU l3a_t3 is required to be provided iri the, report to the 
customer and the internal: DL 

.... encet.....' 

t. The Print Button will then be enabled as above. Cl ick on the Print Button 
u. Save file as "HNG-X - All Live Defects Report for POL - dd.mm.ccyy.pdf" 

6. Go back to "Peak_ Defect_ Management extract dd.mm.ccyy hh.mm.xlsx" and delete the sheet 

you manipulated to create the view for POL 
a. Save the fi le 
b. Close the file 
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• On the day.of issue,.send to Rohit Gogna;. .__._._•__._.__._•_•_GRO._._._•_._._._._._._._._,_and Michelle Stevens 
GRO KinPOL. 

i i 

HNG-X - All Live 
Defects Report for PC 

• Eon r_d.&QQau.Qf.the_S.ent_L#m to POA recipients: Hatch, Matthew 
GRO ;; Bansal, Steve (BRA01) _._._._._._._._._._._._GRO ._._._.-._.-..._ ; Duhaney, 

Joan GRO  ; Bacon, Rosie ;  ; Allen Graham 
(BRA01) ' -- GRO --- -------_-'; Walton, Daniel j-------------------------GRO   I Evans, 
Steve (BAi61)T"""""""""""oixo"" _I Browell, steven < ____.____ GRO 

FW HNG-X - All Live 
Defects Report for PC 
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